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Complete Ansys LS-DYNA 
Support
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Airbags

Airbags



Support for 
*AIRBAG_CPG

A New Airbag Gas Solver



Support for Continuum-based Particle Gas (CPG)

• CPG is a new continuum-based particle approach for airbag simulations, available from Ansys LS-DYNA 

2025R1 (R16).

• As a fully functional fluid solver, CPG is more effective at simulating gas flow than the corpuscular particle 

method (CPM), and more capable at internal fluid-structure interaction than ALE.

• Key features:

• Compressible Navier-Stokes solver coupled with an ideal gas equation of state.

• Meshless by design, based on a generalized finite-difference scheme.  

• Particle cloud fills airbag volume, gas passes from particle to particle (Eulerian approach).

• Particles added or removed only when necessary.

• Excellent accuracy, robustness & scalability to hundreds of cores.

• Designed for airbag simulation, validated by airbag CAE engineers:

• Simple *AIRBAG_CPG keyword format that copies other *AIRBAG_ types.  Same input data for inflators, fabric, etc.

• First release supports internal structures, simple venting, fabric porosity, multiple gases/orifices/inflators, moving environment, 

local particle refinement, and more.

• Inviscid with free-slip boundary by default, although viscosity and wall friction available.

• CPG is destined to take airbag simulation to the next level required for virtual testing, however accurate input 

data and well folded models are also vital to achieve useful results.



Support for CPG Results in D3PLOT

D3PLOT 22.0 supports all CPG data in the new d3dat output file:

• Particle visibility control: Part Tree, Quick Pick, and Entity panels

• Particle symbol size control and visibility per boundary type

• Trace lines, target markers, cut-sections

• Data output (Write to Excel) and composite graphs (XY Data)

We work closely with Ansys to ensure that the Oasys LS-DYNA Environment is the leading choice for CPG workflows

Linked T/HIS

Gas flow

Velocity profile plots can be made using Composite XY Data – 

helps understand flow characteristics though part of the airbag.



Support for CPG Results in D3PLOT

All CPG data components 

can be plotted on particles:

We work closely with Ansys to ensure that the Oasys LS-DYNA Environment is the leading choice for CPG workflows

Flow velocity can be visualised 

using Vector arrows:

Images courtesy of JSOL 

Corporation



Define Material Histories

Define Material 
Histories



• D3PLOT has a new component category called “*DEFINE_MATERIAL_HISTORIES”.

• Components in this category use the user-defined names from the keyword, so you can more easily 

select the component you want.

• Components can be plotted on individual element types or across all element types at once.

• The contour bar is labelled with the component name, resulting in clearer results for reporting.

• The “Extra” component category remains available, so you can still plot extra history variables by 

number, if you prefer.

• This functionality relies on information in the ZTF file, so it must be available. You can generate a 

ZTF file for each model using PRIMER 22.0.

D3PLOT Supports *DEFINE_MATERIAL_HISTORIES Results



*DEFINE_MATERIAL_HISTORIES example
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New category 

DEFINE_MATERIAL_HISTORIES

Component names taken from 

DEFINE_MATERIAL_HISTORIES 

keyword

Component name on contour 

bar



Efficient End-to-End Workflows

12



Movie File Size

Movie File Size



• By default, D3PLOT exports high quality videos at the screen 

resolution of the graphics window(s). For MP4 files, this can result in 

large file sizes. Sometimes, smaller file sizes are desired.

• For MP4 files, a target file size (in megabytes) can now be specified.

• When this option is selected, the required bitrate for the movie is 

determined by that size instead of the Quality (%) slider.

• The file size is a target and is not guaranteed. The actual size of the 

movie file can vary and can typically be smaller than requested by a 

few percent.

Movie target file size



Virtual Testing

• C-NCAP Management Regulation

• Working with Test Data

• Automotive Assessments Improvements

• SimVT Graph Options

• VTC Quality Criteria Workflows

• VTC Videos File Size

Virtual Testing



C-NCAP Management 
Regulation
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Since Oasys 21.1, there has been support for the various 

requirements of the C-NCAP Far Side Occupant 

Protection Protocol, including:

• For each of the eight Working Conditions:

• Occupant injury assessment

• ISO Correlation Fitting indices

• Correction Factor A

• Dual-Occupant Penalty calculation

• ISO correlation fitting indices for the Virtual 

Assessment Certificate (prerequisite for the 

symmetry of far side occupant protection airbags)

• Overall score calculation

Read the documentation to learn more

C-NCAP Management Regulation (2024 Edition)

https://help.oasys-software.com/articles/workflows-22-0/cncap-management-regulation-2024-edition


C-NCAP VTC Quality Criteria

• The C-NCAP VTC Quality Criteria Workflow tool follows the same principals as the Euro NCAP 

version but assesses the quality criteria specified in section H.1.1(f) of the C-NCAP Far Side 

Simulation & Assessment Protocol.

• The tool can be automated using the REPORTER template provided.



C-NCAP VTC Videos

• The C-NCAP VTC Videos Workflow tool follows the same principles as the Euro NCAP version but 

helps you calculate the views and export the videos specified in section H.2.8 of the C-NCAP Far 

Side Occupant Protection Protocol (2024 Edition).

• Use the standard 

Workflow method in 

PRIMER and D3PLOT or 

the whole process can be 

automated using the 

REPORTER template 

provided.



20

Chinese Language Reports 中文版报告模板

• You now have access to all the C-NCAP 

REPORTER templates in both English and 

Chinese, for ease of communication with your 

teams, partners, suppliers, and C-NCAP.

• 所有 C-NCAP REPORTER 模板都同时提供英
文和中文版供您使用，方便您与团队、合作伙
伴、供应商，和 C-NCAP 沟通。 
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Chinese Language Reports 中文版报告模板

• Example reports generated by C-NCAP 

REPORTER templates, in English (left) and 

Chinese (right):

• 下方展示了由 C-NCAP REPORTER 模板自动
生成的英文版（左侧）和中文版（右侧）报告
示例。



Working with Test Data
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• Previously, imported ISO-MME data was assumed to be in SI units. This assumption was not always valid and data with non-standard 

units (e.g. accelerations in ‘g’ or rotations in ‘degrees’) needed to be manually scaled.

• Additionally, the vehicle drive side was inferred from the position code of the first occupant channel, which was assumed to be the driver.

• Now, when importing ISO-MME channel data, T/HIS attempts to automatically determine the units from the unit header in each channel 

file and the drive side from the “Driver position object 1” header in the MME file. However, it is not always possible to correctly infer this 

information.

• The new Import Configuration window (and Import Config. file) gives you the option to correct any issues with the channel units, polarity, 

scale and naming before importing ISO-MME or CSV data.

Improved unit handling and configuration for imported data

Import ISO-MME or CSV data in 

Automotive Assessments 

and SimVT
Data Imported

Import 

Config.

File

Configure import



To accommodate the pre-crash (settling) phase in a simulation, a new “Time of first 

sample” input has been added to the Automotive Assessments workflow set-up in 

PRIMER.

Automotive Assessments and SimVT

• In accordance with ISO-MME convention a negative time value is used to shift the 

start time of the output curves when post-processing using the Automotive 

Assessments or SimVT workflows in T/HIS.

• For example, if your analysis begins with 200 milliseconds of set-up (e.g. seat 

squash etc.) before the crash test load case commences then you would enter -0.2 

in the “Time of first sample” input to shift the curves so that the crash test will 

effectively start at t=0.

• Any data before t=0 is automatically discarded.

LSDYNA to ISO-MME

• The “Time of first sample” value is also used by the LS-DYNA to ISO-MME 

workflow. 

• If it is defined, then the “Time of first sample” header value will automatically be set 

in the channel files.

• Note that in this instance the samples which are shifted to time < 0 will not be 

discarded as this only happens when the ISO-MME data is processed.

Time of first sample



Automotive Assessments 
Improvements

25



• Entity IDs that are defined but don’t have corresponding *DATABASE_HISTORY_XXXX keyword defined are now shown with 

a latent cyan-coloured textbox background:

• A window is now mapped when such entity IDs are selected or typed into the text box, giving you the option to create the 

corresponding *DATABASE_HISTORY_XXXX keyword for them. It also provides an option to select the include file to which 

the keyword will be added. Note: you have to save the include and re(run) the analysis to obtain results for the corresponding 

entity. 

Automotive Assessments Improvements

Dropdown to select the include file

If ticked, then the current layer include will 

be updated to the one selected in the 

dropdown above

Option to provide optional Title



• The ISO channel codes have been updated for several channels in the Far Side VTC v1.1 draft protocol. The necessary 

changes have been incorporated in Automotive Assessments workflows tool, and backward compatibility support has been 

added for the older ISO codes. The channels whose ISO codes have changed are: 

 - LAP Belt (SEBE0003B6FO00 to SEBE0000B6FO00) 

 - Shoulder Belt (SEBE0003B3FO00 to SEBE0000B3FO00) 

 - Contact Dummy-Airbag (ARBG0000WSFOX/Y/Z to AIRB0000WSFOX/Y/Z) 

 - Thoracic Spine 04 and 12 Displacements (THSP04/120000DCX/Y/Z0 to THSP04/1200WSDCX/Y/Z0).

• The 'Far Side + VTC' and 'Far Side' crash tests have been renamed to 'Far Side Sled' for consistency across the tools. The 

version for the former 'Far Side + VTC' is now 2024, while the version for the former 'Far Side' crash test is 2022. Support for 

backward compatibility has also been added. 

• The term Physiology has been renamed to Anthropometry and support for backward compatibility has also been added. 

• Users can now select multiple contacts for contact structures (Contact  Dummy – Airbag, Contact Dummy – Centre Console, 

Contact Dummy –Seat and Contact Dummy - Seatbelt) via SELECT option. 

    

Automotive Assessments Improvements



SimVT Graph Options
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SimVT Graph Options – Show Corridors

• A new graph option “Show corridors” has been added to SimVT 
plotting controls. This determines whether the inner and outer 
corridors are plotted along with the reference and simulation 
curves.

• Deselecting show corridors can help reduce clutter on the 
graphs.

Corridors turned on Corridors turned off



VTC Quality Criteria 
Workflows

30



• The Euro NCAP VTC Quality Criteria Workflows 

tool and associated REPORTER Template are now 

capable of assessing the Euro NCAP Virtual 

Frontal Simulation & Assessment Protocol (draft) as 

well as the existing Far Side protocol.

Quality Criteria – Euro NCAP Frontal



• The Euro NCAP HBM Quality Criteria Workflows tool 

and associated REPORTER Template allow you to 

perform the quality checks outlined in Section 7.1 of 

the Euro NCAP VTC HBM Frontal Protocol (draft) 

relating to energy, added mass and displacements.

Quality Criteria – Euro NCAP HBM



VTC Videos File Size
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• The displayed End time is now determined by model simulation end time rounded down to three 

decimal places rather than model simulation end time minus 1 interval step (which had caused 

issues with video capture previously).

• For the Euro NCAP version, the Video Quality slider has been replaced with a target file size option 

to allow users to satisfy the 1-10 MB video requirement. 

VTC Videos Settings Improvements



Human-Safe Design
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Automotive Protocols

Automotive Protocols
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New Protocols and Regulations

• Automotive Assessments and REPORTER 

now support the following new protocols and 

regulations:

Regulation Loadcase

C-NCAP Far Side Occupant Protection

Global NCAP MDB, ODB, Side Pole

JNCAP FFB, MDB, ODB

KNCAP FFB, MDB, Side Pole

UN ECE R94, R95, R135, R137



• The following protocols have been updated:

Upgraded Protocols

Regulation Loadcase Update

Euro NCAP MPDB Occupant Assessment
• 2024 (Follows Adult Occupant Protocol v9.3)

• Includes DAMAGE assessment

IIHS Front SOB
• 2024 (Version VII)

• New fuel modifier

IIHS Side MDB
• 2024 (Version IV)

• New fuel modifier and updated head protection rating system



Latest Protocol Support
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Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

C-NCAP

2018 ODB ● ● ●

2021
Head Impact ●

Leg Impact ●

2022 MPDB Occupant ● ● ●

2023 MPDB Compatibility ●

2024

Side Pole ● ● ●

Far Side Pole ● ● ●

Far Side Sled ● ● ●

VTC Quality Criteria ● ● ●

VTC Videos ● ● ●

LS-DYNA to ISO-MME ● ● ●

SimVT ● ●

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Latest Protocol Support
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Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

Euro NCAP

2017
FFB ● ● ●

ODB ● ● ●

2020

MPDB Occupant ● ● ●

Side Pole ● ●

MDB ● ● ●

2022

Far Side ● ● ●

MDB ● ● ● ●

Side Pole ● ● ●

2023

MPDB Compatibility ●

Head Impact ●

Leg Impact ●

Continued…

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Latest Protocol Support
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Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

Euro NCAP

2024

Far Side Sled ● ● ●

MPDB Occupant ● ● ●

VTC Quality Criteria ● ● ●

VTC Videos ● ● ●

LS-DYNA to ISO-MME ● ● ●

SimVT ● ●

2026 

(Draft)

Front Sled
Early access – available on request

FWDB Full Vehicle

VTC Quality Criteria ● ● ●

VTC HBM Quality Criteria ● ● ●

SimVT Early access – available on request

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Latest Protocol Support
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Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

Global NCAP

2022 MDB ● ● ●

2023 ODB ● ● ●

2024 Side Pole ● ● ●

GTR
2019 Leg Impact ●

2020 Head Impact ●

IIHS
2017

MDB ● ● ●

ODB ● ●

SOB ● ●

Continued…

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Latest Protocol Support

43

Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

IIHS

2021

MDB ● ● ● ●

MDB Structure Only ●

ODB ● ● ●

ODB Structure Only ●

SOB ● ● ●

SOB Structure Only ●

2024

MDB ● ● ●

MDB Structure Only ●

SOB ● ● ●

SOB Structure Only ●

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Latest Protocol Support
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Regulation Year Loadcase/Workflow PRIMER T/HIS D3PLOT

REPORTER 

(migrated to 

workflows)

REPORTER 

(standard 

template)

JNCAP

2018 Leg Impact ●

2023

FFB ● ● ●

MDB ● ● ●

ODB ● ● ●

KNCAP

2019 Leg Impact ●

2024

FFB ● ● ●

MDB ● ● ●

Side Pole ● ● ●

UN ECE

2015 R135 (Side Pole) ● ● ●

2022 R94 (ODB) ● ● ●

2023
R95 (Side MDB) ● ● ●

R137 (FFB) ● ● ●

● Available for some time

Automotive Assessments Workflow ● New in version 21.1

● New in version 22.0



Speed and Performance
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Envelope Data

Envelope Data



• An envelope plot is a contour plot of data across 

all (or several selected) states in a model – 

typically used to check the maximum values that 

have occurred across the duration of a 

simulation.

• We’ve recognised that sometimes envelope plots 

can take a while to calculate because of the size 

of a model.

• D3PLOT now has the capability to save and 

retrieve enveloped data. This means that once 

you have computed the envelope plot, you can 

save and retrieve it for rapid reuse later in the 

session or in future sessions.

• Retrieving a saved envelope plot is many, many 

times faster than computing it from scratch.

47

Saving and Retrieving Envelope Data



• Upon clicking the “Calculate and Write” button, 

D3PLOT will loop through all currently active windows 

as designated by the data panel window selection.

• Any windows that are active and have models which 

have components that are valid for enveloping will 

automatically be calculated and the envelope data will 

be placed within an envelopes.h5 file within the 

respective model results directory.

Saving an Envelope – Interactive



• To save time, you can write the envelope data as a batch process – for 
example, as a step to complete automatically at the end of your LS-
DYNA run.

• You will first require a Settings file:

• For each envelope plot, create a unique Window in your D3PLOT session, 
add the same model to each, and configure the envelope plot.

• Write a Settings file from the File menu.

• Then for a given run you can issue the following command:

<install-dir>/d3plot22_x64.exe -d=batch -env_out
-set="<settings file path>/d3plot001.set" 
"model_path/model_filename.d3plot"

• When the -env_out command is issued, it will flag all the components 
you had setup in the settings file to automatically calculate the envelope 
data and then write to the corresponding model’s path with the 
“envelopes.h5” file.

Saving an Envelope – Batch



• The batch mode currently has the limitation that each settings file should contain a single model. For 

multiple LS-DYNA runs you will have to loop each *.d3plot/*.ptf output with the same settings file.

• Currently, the batch mode can only output envelopes across all states rather than over a selected 

subset of states.

• Currently, envelope data is always written to an envelopes.h5 file in the results directory. In future 

versions, we will aim to make output directory and filename more flexible.

Saving an Envelope – Limitations



• Upon clicking Retrieve from File and selecting your file you will be greeted with a list of the 

envelopes saved within it.

• Hovering a Data Component will give you more context about the envelope data:

Retrieving an Envelope



• You can then map this data onto another model present in your session that corresponds to the 

model it was saved from:

Retrieving an Envelope (continued)



• If the model you’re trying to map onto does not match the model data from the envelope that you 

have saved, you will not be able to retrieve the envelope onto it

• This could either be missing entity metadata (e.g. a different number of elements) where you are not 

permitted to read.

• Or it could be that you have moved the envelope file or model to a different directory, but you will be 

permitted to read.

Retrieving an Envelope (continued)



Data Plots

Data Plots



• Large models can take a long time to update, so by default, D3PLOT 

doesn’t automatically refresh data plots when you make changes in the 

Data menu.

• A new panel has been added that allows you to control when data plots 

are refreshed automatically:

• For models smaller than a certain size (number of nodes)

• When you change specific settings

• When envelope plots are active

• If the automatic refresh options are deactivated and a manual refresh 

is required, click the “Data Plot Refresh” button.

Data Plot Refresh Options



100M+ Element Models

100M+ Element Models



We have had the opportunity to work on a gigacasting project featuring a model with 330 million 

elements and 70 million nodes. 

This presented problems because the lengths of some data vectors exceeded the ~2.147e9 limit (231-

1) imposed by 32-bit signed integer arithmetic, with the result that some internal calculations 

overflowed.

In D3PLOT 22, those limits have been removed by substituting 64-bit arithmetic and models of this 

size are now processed successfully.

Improvements for very large models



Email Minidump Files

Email Minidump Files



• Following a crash on Windows a “minidump” file is created which, if sent, can sometimes enable us 

to diagnose the cause of the crash, suggest workarounds and fix the bug. Historically this file has 

been written to an obscure temporary directory making it laborious to extract and send it.

• D3PLOT can now:

• Compose an email automatically, attaching the minidump file.

• Include further information about the crash (stack trace) in that email.

• Launch the default email handler on the system so that you can add further information if you wish.

• This email is not sent automatically, you can choose to send it or not.

• Composition of these emails is optional; they can be turned off.

Windows Minidump files can now be emailed
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• Minidump files and crash handling generally can be 

configured by preferences, but to make this easier there is 

now an interactive GUI which can be used to control this 

behaviour:

• Crash dump behaviour can also be configured at the “admin” 

or “installation” levels during software installation, configuring 

it for all users.

Email Minidump Files (continued)



Initial Window Placement

Initial Window Placement



• On a multi-monitor desktop, the “placement” preference can be used to select which of multiple 

monitors on a desktop the master D3PLOT window starts in. Previously this was always the main 

display window. The bounding box (red) around the monitors (black) that make up the desktop in 

pixel space which is divided into 1/3rds. For example:

The preference value may be a combination of

LEFT | CENTRE | RIGHT 

             and / or

TOP | MIDDLE | BOTTOM         The monitor nearest to the centre of that 1/3rd sub-area is used.

Initial Window Placement



Flexible Automation and 
Integration
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D3PLOT-PRIMER Integration

D3PLOT-PRIMER Integration



• D3PLOT now preserves the blanking Lock status when an Unblank action is carried out in linked 

PRIMER sessions (and vice versa).

Linked PRIMER Session Blanking Lock Behaviour

PRIMER D3PLOT

Linked session



JavaScript API

JavaScript API



• It is no longer necessary to specify the memory required when running a script.

The memory is now automatically increased as required.

• The GetAll and GetFlagged methods available for several classes can now take an optional 

argument, which is a property from the object to return in the array, instead of the object itself.

• The following has been added to the Part class:

• A composite property which returns true if the Part is a *PART_COMPOSITE

• A nip property to get the number of integration points in a *PART_COMPOSITE

• A GetCompositeData() method to get the Material ID and Thickness at a specified integration point in a 

*PART_COMPOSITE

JavaScript API



• The function assigned to the Window onClose event can now return false to prevent the window 

closing if required.

• GetTargetEye and SetTargetEye instance methods have been added to the GraphicsWindow 

class to enable getting/setting the target and eye position.

JavaScript API



Python API

Python API



• The GetAll and GetFlagged methods available for several classes now work for very large lists. In 

version 21 there was a limit of ~300,000 items.

• Similarly, the GetMultipleData method for several classes also had a limit which has now been 

removed.

Python API



Other Developments and 
Preferences

71



Cut Sections

Cut Sections



• For Cut Sections, the "View on 

Plane" button under the Display 

Settings section now orients to face 

the most transparent side.

• Priority of transparency: Omit, 

Outline, Transparent, then Normal.

• For ease of use, the "V" shortcut key 

(uppercase “V” – lowercase “v” 

shortcut is for the View menu) now 

sets the currently active window to 

"View on Plane”.

View on Plane Behaviour



• The cut forces table can now be sorted by clicking on column headers similarly to the Write table.

Cut Forces Table



• There are now preferences

d3plot*cut_section_pos_action

and

d3plot*cut_section_neg_action

for positive and negative actions of cut sections.

New preferences



Eigenmode Magnification

Eigenmode Magnification



• New controls to modify eigenmode model (d3eigv, Nastran, and 

OptiStruct) magnification factors after they have been read in 

have been added to the Deform → Magnify panel.

• Both absolute and percentage factors can be set, just like in the 

OPEN PLOT FILE menu.

• Note that the magnification value specified in this panel overrides 

the value set in the OPEN PLOT FILE panel. The two values are 

not applied to the model in a compound way.

Eigenmode Magnification Controls



Label Background

Label Background



• New “Fixed Label Background” option in Display Options → Label 

Options maps a background to increase legibility of fixed labels that do not 

move with the model.

• This includes header, clock, contour bars, deform factor and any other 

‘fixed’ label written in the graphics area.

• Additionally, an option is given to adjust the transparency of these 

backgrounds.

Label Background

Fixed Label 

Background

Label 

Background

• Inactive by default, this can be changed using: 
d3plot*fixed_label_background



• Changes have been made to the way Display Options → Window Dressing → 

Window size → Part Screen works.

• The graphics window area in Part Screen mode will now dynamically adjust to 

the maximum possible available area that can be used without overlapping with 

the header or the contour bar.

• Full screen by default, this can be changed using: d3plot*window_mode

Window Dressing – Part Screen

Part Screen 

Graphics Area



New Preferences
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New Preferences



Preference Description

oasys*javascript_maximum_memory_size Maximum memory allocated for garbage collection (MB)

oasys*cd_compose_email

d3plot*cd_compose_email

Whether or not to offer to compose an email for sending 

minidump files.

oasys*cd_email_address

d3plot*cd_email_address

Email address in To: field of crash dump emails.

oasys*cd_cc_addresses

d3plot*cd_cc_addresses

Email address(es) in Cc: field of crash dump emails.

oasys*cd_custom_email

d3plot*cd_custom_email

Custom method of sending emails.

oasys*cd_dump_directory

d3plot*cd_dump_directory

Directory in which to save crash dump files

oasys*cd_email_method

d3plot*cd_email_method

Method used to create crash dump emails.

oasys*cd_minidump_file

d3plot*cd_minidump_file

Whether or not to create minidump files, and what to do 

with them.
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Preference Description

d3plot*cut_section_cap2d_fac2 True-thickness-constant factor for shell element cut 

section capping

d3plot*cut_section_neg_action Negative action for cut sections

d3plot*cut_section_pos_action Positive action for cut sections

d3plot*cache_data_mode How data storage is managed

d3plot*cache_data_limit Percentage of memory used at which automatic storage 

switches to scalar

d3plot*recycle_tensors Percentage of memory used at which unused tensor 

data is evicted from memory

d3plot*data_refresh_max_model_size Maximum number of nodes allowable for any model in 

any window for an immediate refresh

d3plot*data_refresh_max_model_size_on When TRUE, enable the max model size (#nodes) 

option for immediate refreshes

d3plot*data_update_on_envelope_on When TRUE, the plot is updated regardless of the 

envelope status if needed
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Preference Description

d3plot*data_force_refresh_opts When set to ALL, all data plot refresh on change 

settings tick boxes are ticked

d3plot*fixed_label_background Fixed label background display

d3plot*window_mode Controls how the graphics window occupies the screen

d3plot*cpg_visibility CPG (Airbag Continuum-base Particle Gas) visibility

d3plot*des_visibility DES (Discrete Element Sphere) visibility

d3plot*sph_visibility SPH (Smooth Particle Hydrodynamics) visibility
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Contact us

Global / UK
T: +44 121 213 3399

E: dyna.support@arup.com   

India
T: +91 40 69019723 / 98

E: india.support@arup.com 

China
T: +86 21 3118 8875

E: china.support@arup.com 

USA
T: +1 415 940 0959

E: us.support@arup.com 

www.oasys-software.com/dyna/ 

Subscribe to 
our newsletter:

@Oasys LS-DYNA 
Environment

@Oasys LS-DYNA 
Environment

@Oasys @Oasys

Follow us on: 

mailto:dyna.support@arup.com
mailto:india.support@arup.com
mailto:china.support@arup.com
mailto:us.support@arup.com
https://www.oasys-software.com/dyna/
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